CREATING AN EFFECTIVE POSTER

UNC Health Sciences Library  February 13, 2019
Karen Grigg/ kgrigg@email.unc.edu
Barbara Renner / brrenner@email.unc.edu
ABOUT THE PRESENTERS

Karen Grigg: As the Health Sciences Librarian for Collections and Instruction, Karen selects and promotes library resources to the medical campus and hospital, along with providing consultation, training, and research support.

Barbara Renner: With a PhD in educational research and evaluation methodology and clinical training in Audiology, Barbara Renner is library services evaluation specialist and liaison to the Allied Health Sciences, where she is an adjunct professor.
OVERVIEW

✓ About Poster Presentations [7 min]
✓ Quick Tips & Useful Resources [15 min]
✓ Poster Critique [7 min]
✓ Your Questions (& Answers) [5-10 min]
WHY A POSTER?
(VS. PRESENTATION OR PAPER)

- Opportunity for professional engagement
- Visual + Discussion = Poster
- You might have spent a long time on your research, so it can be hard to cut down into something people can understand quickly. That’s basically the job of a poster.
- The main point of making a poster is that you want to tell people about your research in a relatively quick bite. To do so, you need to zero on what’s most important about what you did or found.
WHAT’S YOUR MESSAGE?

Title

- Choose a title that tells people what your research is about.
- Try to catch people’s attention

Text

- Keep it as short as you can while still giving a useful explanation of your research.
- Not more than 300-800 words!
- Think about why someone who hasn’t done this research should care about it. What will your audience find interesting about it?
CONTENT: SECTIONS YOU COULD INCLUDE

- Title (including author/s and program affiliation)
- Introduction
- Methods
- Results
- Discussion and Conclusion
- References
- Any tables, figures, and photos
- Your Contact Information
- Grant Acknowledgement Statement/Information
GOOD COMMUNICATION?

A minicab driver picks up the radio and calls base.

Cabbie: B52
Base: C5
Cabbie: OK

Passenger: Excuse me, could you explain what that was all about?

Cabbie: I just wanted to know where to pick up my next fare.

HOW MUCH JARGON (AND ACRYONYMS) WILL YOUR AUDIENCE UNDERSTAND?
FOLLOW THE INSTRUCTIONS... 
...OF YOUR CONFERENCE
QUICK TIPS & USEFUL RESOURCES
UNC HSL LIBGUIDES: DESIGNING EFFECTIVE POSTERS
HTTPS://GUIDES.LIB.UNC.EDU/POSTERS

Learn how to design and publish effective posters. This guide includes sections on design elements, the poster design process, and using software to create posters.

Welcome! The purpose of Designing Effective Posters is to help you communicate through a poster. This tutorial includes the following sections:

**Design Elements** presents criteria for determining the effectiveness of a poster. Use these criteria as guidelines for designing your poster.

**Design Process** describes the tasks for creating a poster. Refer to this section for help with planning and carrying out your poster project.

**Using Software** describes techniques for creating a poster with software programs, including Microsoft Powerpoint for Windows, Powerpoint for Macintosh, and Adobe InDesign (both Windows and Mac).

This tutorial does not assume any knowledge of poster design or software, though some background in Powerpoint or InDesign would be helpful. The Using Software sections focus on using these programs for creating posters. They do not discuss many features of the programs not specific to creating posters.

- Design Elements
- Design Process
- Using Software
UNC HSL LibGuides: Designing Effective Posters
HTTPS://GUIDES.LIB.UNC.EDU/POSTERS

Design Elements overview

Design Elements

This section describes elements of an effective poster. It is divided into pages for Content, Design and Layout, and Graphics.

This section also includes a poster evaluation checksheet to help you increase your awareness of and skill in designing posters, along with examples of posters that you can use for evaluation practice.

To learn about design elements, click on the following links to pages within this section:

Design Elements: Content
Design Elements: Design and Layout
Design Elements: Images and Graphics
Poster Evaluation Checksheet
Examples

✓ Design Elements
✓ Design Process
✓ Using Software
FOLLOW YOUR READERS
TEXT COLORS/BACKGROUND

Dark on light?

Light on dark?
FUN WITH FONTS! (AND FONT SIZE)

Titles

Serif Fonts e.g. Times New Roman & Sans Serif Fonts e.g. Arial

Headers & Main text have different sizes

One style for your title and one for your main text is appropriate. Include no more than two font styles in the poster.

But be consistent with font size and don’t vary too much.

Captions and References can be smaller text size.
MAKE YOUR OWN IMAGES

- Smart Art and Shapes!
- Just take photos! (caution: confidentiality)
- Excel charts!
- Insert a chart or graph in PowerPoint!
Public Domain
Creative Commons

FIND IMAGES

- Attribution – acknowledge and name the author/creator of the work
- Non-commercial – the work may not be used in a commercial product – i.e. sold for profit
- No Derivative Works – no remixing or editing of the original image/work is allowed
- ShareAlike – remix only if you let others remix whatever is created as a result
FINDING CREATIVE COMMONS IMAGES
IMAGE RESOLUTION

NIH Fogarty

Original image

Pixelated image
# Poster Evaluation Checksheet

Use this checklist to evaluate posters. We suggest assigning points to a poster with the following values: 1 = poor; 2 = fair; 3 = average; 4 = good; 5 = excellent.

Can you think of other criteria that aren’t on this list? If you do, let us know.

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Rating</th>
<th>Notes (How could this be improved?)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Purpose</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relevant and Significant</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Essential</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organized</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear and Concise</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design and Layout</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alignment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Balance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White space</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consistency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Headings and Fonts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photographs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagrams, Charts, and Artwork</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Create Your Poster

Brainstorm Content
Consider what information is necessary to communicate your message. Remember, you most likely do not need to include all of the information gathered, so choose only the information and graphics pertinent to conveying your message.

Structure Content
Once you've decided what information to include in your poster, focus on organizing and arranging your ideas. For this purpose, you may wish to use notecards, or software such as the outliner in Microsoft Word or a mind mapping program such as Mind Manager. Organize the information you want to present into major topics (such as Background, Methods, Results, Conclusions) and subtopics.

For more information on poster content, see the Content page in the Design Elements section of this tutorial.

Layout and Design
A clear visual layout is essential to an effective poster. You may want to start by drawing a rough sketch of your poster in order to get an idea of how you want to arrange text and images. For more information on layout and design, see the Design and Layout page.

Create your poster on a computer
To create your poster on the computer, you need to decide which software you want to use. We recommend Adobe InDesign, which is an excellent page layout program. However, some people have gotten good results using Microsoft PowerPoint, which is more widely available. For more information, see the Using Software section of this tutorial.

Find out more about the Design Process on the LibGuide!
Using Software Overview

Using Software

This section describes techniques for creating a poster using Microsoft PowerPoint and Adobe InDesign for Windows and Macintosh platforms.

Some background in PowerPoint or InDesign is helpful but not required. This section does not discuss many features of the programs not specific to creating posters.

To learn software techniques for creating a poster click on one of the following:

- PowerPoint 2016 and 2013 for Windows
- Powerpoint 2010 for Windows
- PowerPoint 2016 for Macintosh
- Powerpoint 2011 for Macintosh
- Adobe InDesign (Macintosh and Windows)

- Design Elements
- Design Process
- Using Software
PowerPoint for Windows versions 2016 and 2013 are very similar.
To specify the dimensions of the poster click the Customize icon under the Design tab. Then click Slide Size.

In the Slide Size dialog box, enter the Width and Height for your poster. For example, a typical poster could be 56" wide by 36" high. Be sure that the printer you plan to use is able to print at the size you specify.
Wrapping text around objects like tables, pictures, shapes, charts, and SmartArt graphics is not supported in PowerPoint. Consider multiple text boxes around the object.
PRINTING LARGE POSTERS

- Make sure your printer can print your poster size!

- The maximum page (slide) size in Powerpoint is 56" by 56".

- To create larger posters, check out the LibGuide, the tips to the right.

Tips

- If you want a poster that is longer or wider than 56" we suggest that you create your poster at half-size. Then when you print it, print it at 200% size. For example, if you want your finished poster to be 40" by 80", set your poster size to 20" by 40". Then print it at 200%.

- Keep in mind that if you are creating your poster at half-size, everything in it (text, heading, charts, images) will end up being twice as large in your finished poster. So, for example, if you create a title that has a font size of 48 points, in the final poster it will be 96 points.
PRINT A REDUCED SIZE / HANDOUT OF YOUR POSTER

- Click File > Print
- Then select “Full Pages Slides”
- Check the box next to “Scale to Fit Paper”
POSTER CRITIQUES
(AND BETTER EXAMPLES)
WHAT'S WRONG WITH THIS POSTER?

Charting the Pharmaceutical Education Literature: Past, Present... and Future

KTL Vaughan, MSL, University of North Carolina at Chapel Hill/Health Sciences Library; William H. Campbell, PhD, University of North Carolina at Chapel Hill School of Pharmacy

Objective
This study characterizes major themes and trends in the pharmaceutical education (PE) literature of the past 35 years by analyzing subject headings assigned to a core set of articles from the American Journal of Pharmaceutical Education (AJPE).

Hypotheses
- The PE literature is growing faster than the overall pharmaceutical literature.
- Major themes in the literature can be identified using subject heading analysis (bibliometrics).
- Trends in the literature can be quantified using bibliometrics.
- Publication trends reflect policy and program trends in pharmacy education.
- Trend analysis may predict future areas of PE.

Methodology
- Downloaded citation and subject heading information from the International Pharmaceutical Abstracts (IPA).
- Combination of MeSH and domain-specific subject terms.
- Only complete index of AJPE for study period.
- Managed citations using EndNote and ReWorks databases.
- Identified most popular subject headings and categories.
- Graphed trends as a percent of articles per year.

Trends
- Curriculum-related publications are the most frequent of all AJPE topics for the entire 35-year period of study.
- Technology-related publications appear to increase in a manner consistent with general interest in internet and distance education.
- Manpower-related publications peaked during the 1980s, reflecting the nation's priorities for research and expansion in this area.
- 'Clinical pharmacy' and 'PharmD' appear to be strongly correlated, but with a lag of 2-3 years. It will be interesting to observe whether these topics continue now that the PharmD debate is resolved.
- Topics in the pharmacy education literature appear similar in content and relative frequency to other health professions, although this should be empirically determined through literature analysis.

Major Themes in Pharmaceutical Education
- Subject heading analysis identified 906 categories of subjects, with 10,351 total subject headings.
- The number and percent of articles containing a subject category was determined. Several subject categories constitute a significant proportion of the overall PE literature from 1970-2005:
  - Curriculum (37%)
  - Sociology, economics, and ethics (21%)
  - Pharmacy practice (16%)
  - Administration (15%)
  - Degrees (10%)
  - Information processing and literature (10%)

Using Bibliometrics for Literature Analysis
- Subject heading analysis ("Bibliometrics") works as a tool for quantitatively analyzing themes and trends in a body of literature due to the unique nature of controlled subject headings.
- Subject headings describe the "aboutness" of an article more succinctly than an abstract and title.
- Controlled vocabularies such as MeSH allow for flexibility in free text and uniformity in indexing.

Major Trends in Pharmaceutical Education
- Trend #1: Curriculum, Health, & Training
  - Search curriculum OR teach OR learn
  - There has been a significant increase in the proportion of articles published on curricular issues in the past 35 years. Surges have occurred around the late 1970s, early 1980s and the late 1990s. In 2004-05, approximately three quarters of AJPE articles were about curricular topics.

- Trend #2: Resources & Technology & DI
  - Search information processing OR computer OR [Internet OR World Wide Web OR WWW]
  - Technology has led to a substantial increase in literature, at approximately 1% of the literature, while information processing and computers are increasing rapidly. Interest/WWW has had a dramatic increase in the last ten years.

- Trend #3: Manpower & Personnel Issues
  - Search [Manpower OR personnel OR job] OR [men OR women OR more] OR [job] [short OR long] OR [stake OR shortage OR poor OR unserved OR segment]: OR pay
  - This thematic area saw a peak in publications in the late 1980s, but has been declining as a proportion of AJPE articles to approximately 2% in 2004-05.

- Trend #4: Clinical Pharmacy & the PharmD
  - Search [Degrees OR Pharmacy OR PharmD OR clinical pharmacy OR drugs OR clinical OR nurses]: OR [clinical] OR [dose]: OR [clinical]
  - As expected, peaks in interest coincide with the PharmD vs. BPharm debates of the mid-1980s and 1990s. Note that peaks in clinical pharmacy articles happen roughly two years before peaks in PharmD publications.
**WHAT MAKES THIS BETTER?**

**Charting the Pharmaceutical Education Literature: Past, Present ... and Future?**

K.Y.L. Vaughan, MSLS, University of North Carolina at Chapel Hill Health Sciences Library; William H. Campbell, PhD, University of North Carolina at Chapel Hill School of Pharmacy

**Objective**

This study characterizes major themes and trends in the pharmaceutical education (PE) literature of the past 55 years by analyzing subject headings assigned to a core set of articles from the American Journal of Pharmaceutical Education (AJPE).

**Hypotheses**

1. The PE literature is growing faster than the overall pharmaceutical literature.
2. Major themes in the literature can be identified using subject heading analysis (bibliometrics).
3. Trends within these themes can be quantified using bibliometrics.
4. Publication trends reflect policy and program trends in pharmacy education.
5. Trend analysis may predict future areas of PE.

**Methodology**

- Downloaded citation and subject heading information from International Pharmaceutical Abstracts (IPA).
- Combination of MeSH and domain-specific subject terms.
- Only complete index of AJPE for study period.
- Managed citations using EndNote and RefWorks databases.
- Identified most popular subject headings and categories.
- Graphed trends as a percent of articles per year.

**Growth of PE Literature**

All three categories of literature (overall, PE, and AJPE) show growth in annual number of articles published over the study period.

**Major Themes in Pharmaceutical Education**

Subject heading analysis identified 966 categories of subjects, with 10,351 total subject headings.

- The number and percent of articles containing a subject category was determined.
- Several subject categories constitute a significant proportion of the overall PE literature (e.g., 1970-2005).

**Major Trends in Pharmaceutical Education**

**Trend #1: Curriculum, Teaching, & Learning**

- There has been a significant increase in the proportion of articles published on curricular issues in the past 35 years.
- Surges have occurred around the late 1970s/early 1980s and the late 1990s.
- In 2004-05, approximately three quarters of AJPE articles were about curricular topics.

**Trend #2: Instructional Technology & DR**

- Information processing (e.g., computers, Internet, World Wide Web) is a stabilizing force in pharmaceutical education.
- "Technology" is a stable term, at approximately 1% of the literature, while information processing and computers are increasing gradually.
- Internet/WWW has had a dramatic increase in the last ten years.

**Trend #3: Manpower & Personnel Issues**

- This thematic area saw a peak in publications in the late 1960s, but has been declining as a proportion of AJPE articles to approximately 2% in 2004-05.

**Trend #4: Clinical Pharmacy & the PharmD**

- As expected, peaks in interest coincide with the PharmD vs. BPharm debates of the mid-1980s and 1990s. Note that peaks in clinical pharmacy articles happen roughly two years before peaks in PharmD publications.

**Trends**

- Curriculum-related publications are the most frequent of all AJPE topics for the entire 35-year period of study.
- Technology-related publications appear to increase in a manner consistent with general interest in internet and distance education.
- Manpower-related publications peaked during the 1980s, reflecting the nation’s priorities for research and expansion in this area.
- "Clinical pharmacy" and "PharmD" appear to be strongly correlated, but with a lag of 2-3 years. It will be interesting to observe whether these topics continue now that the PharmD debate is resolved.

- Topics in the pharmacy education literature appear similar in content and relative frequency to other health professions, although this should be empirically determined through literature analysis.

**Using Bibliometrics for Literature Analysis**

- Subject heading analysis ("bibliometrics") works as a tool for quantitatively analyzing themes and trends in a body of literature due to the unique nature of controlled subject headings.
- Subject headings describe the "abstractness" of an article more succinctly than an abstract and title.
- Controlled vocabularies such as MeSH allow for flexibility in free text and uniformity in indexing.
Chapting the Pharmaceutical Education Literature: Past, Present ... and Future?

**Objective**

The study characterizes trends and trends in the pharmaceutical education literature from the past 25 years by analyzing subject headings from a set of outlets from the American Journal of Pharmaceutical Education (AJPE).

**Hypotheses**

- The AJPE literature is growing faster than the overall pharmaceutical literature.
- Major trends in the literature can be identified using subject headings in AJPE.
- Trends within the literature can be identified using subject headings.
- Evaluations of overall and program performance can be made.
- Trend analysis may provide future areas of focus.

**Methodology**

- Created a database of subject headings.
- Identified articles containing subject headings specific to the topic.
- Created a table of subject headings for each article.
- Calculated the frequency of each subject heading.
- Calculated the frequency of each subject heading for the entire period.
- Calculated the percentage of articles containing each subject heading.

**Trends**

- The AJPE literature is growing faster than the overall pharmaceutical literature.
- Major trends in the literature can be identified using subject headings in AJPE.
- Trends within the literature can be identified using subject headings.
- Evaluations of overall and program performance can be made.
- Trend analysis may provide future areas of focus.

**Using Bibliometrics for Literature Analysis**

- Subject headings analysis identifies trends in the literature.
- Subject headings analysis identifies trends in the literature.
- Subject headings analysis identifies trends in the literature.

**Major Theme in Pharmaceutical Education**

- Technology: "Technology" is a major theme, approximately 8% of the articles in the literature analyzed.

**Conclusion**

- The AJPE literature is growing faster than the overall pharmaceutical literature.
- Major trends in the literature can be identified using subject headings in AJPE.
- Trends within the literature can be identified using subject headings.
- Evaluations of overall and program performance can be made.
- Trend analysis may provide future areas of focus.

**Using Bibliometrics for Literature Analysis**

- Subject headings analysis identifies trends in the literature.
- Subject headings analysis identifies trends in the literature.
- Subject headings analysis identifies trends in the literature.
WHAT'S WRONG WITH THIS POSTER?

Same Space: New Uses

Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

To create a more flexible, user-friendly and self-evident facility an entrance was added on the street side of the building. Introducing curved forms and rich woods softened the interior. The stairs and elevators were reintegrated into an open stairway with floor penetrations allowing visual contact between floors, and admitting natural light to the basement. A café was placed near the street entrance to encourage a sense of community and a place for informal meeting and exchange. A single service point was designed to provide a physical gateway to the library’s services and collections.

The HSL at UNC-CH is undergoing a total renovation in two phases, the first of which is completed. The Library is a 90,000 square foot building on a “land-locked” location. To achieve the vision of a learning and teaching library we needed to address significant issues through programming and design. This poster will deal with four themes.

Goal: Keep collections while gaining space for learning, discovery, and technology

The ratio of space usage in building was reallocated from 45% for collections, 32% for users, and 23% for staff, to 32%, 39%, and 29% respectively. Since a goal was to keep the collections on site while gaining space for learning, discovery, and technology, extensive use was made of compact shelving. 12,000 square feet was converted from housing collections to other purposes.

Furniture "systems" and movable partitions maintain future flexibility. Enclaves to accommodate small meetings were distributed throughout library departments. Support for various learning styles was provided.

Study rooms were enlarged and designed to support group work interacting with technology. Three classrooms provide large group instruction at hands-on workstations, more informal workshops, and teleconferencing. Two computer labs provide access for over 60 individuals. A large space was designed for flexible programming and for exploration, demonstration, research and development involving advanced technology.

Every seat in the library has a connection to the Internet, most hardwired and powered, some wireless. A new server room supports up to 40 servers.

An emergency generator will support not only life and safety concerns, but keep many of the library’s electronic services running in the event of a power outage.

“Learning technology should be unobtrusively and ubiquitously supportive and it should enable us to re-humanize learning spaces.”

—William J. Mitchell, MIT

Space Allocation

- New Collection
- Movable Partition
- Furniture System
Same Space, New Uses: Transforming the Library for the 21st Century

Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

Background

- The Health Sciences Library is undergoing a total renovation in two phases, the first of which is completed.
- Goal: Renovate 90,000 square foot library to achieve the vision of a learning and teaching library.

Inviting Environment

- Single service point provides gateway to services and collections
- Unobtrusive technology
- Curved forms and rich woods soften the interior
- Stairs and elevators reintegrated into an open stairway, admitting natural light
- Café added to encourage a sense of community and informal meeting place

Flexible Functionality

- Furniture and partitions maintain future flexibility
- Study rooms support group work interacting with technology; enclaves accommodate small meetings
- Three classrooms for large group instruction at hands-on workstations, teleconferencing
- Two computer labs provide access for over 60 individuals
- Large space for exploring advanced technology

Upgraded Infrastructure

- Every seat has an internet connection, most hardwired and powered, all covered by wireless
- New server room supports up to 40 servers
- Emergency generator keeps many electronic services running in the event of a power outage

Lessons Learned So Far

- Prepare for sudden aggravation
- Staff morale is key
- “Stressed is dessert spelled backwards”
Same Space: New Uses
Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Clive Design Associates, PA, Raleigh, North Carolina

To create a more flexible, user-friendly, and self-evident library environment, new study areas and service desks were added on the first floor, which also features a large, open reading area.

- The 50,000 square foot building is designed to accommodate up to 350,000 users.
- New study area includes a quiet study room and a group study room.
- The library is equipped with wireless internet access and ample seating.
- The library also offers a wide range of resources, including an extensive collection of books and periodicals.
- A large window provides natural light, enhancing the overall atmosphere.

Space
- 3,000 square feet of new study area
- 2,000 square feet of existing study area

Inviting Environment
- Colorful and inviting design
- Large windows
- Comfortable seating
- Artwork and murals

Flexible Functionality
- Multiple use areas
- Adjustable lighting
- Technology integration

Upgraded Services
- New electronic access
- 24/7 access
- Increased collection size

Lessons Learned So Far
- Engage stakeholders early and often
- Communicate effectively
- Plan for future growth

Same Space, New Uses: Transforming the Library for the 21st Century
Jim Curtis, Carol Jenkins, and Bob Ladd. Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Clive Design Associates, PA, Raleigh, North Carolina

Background
- The Health Sciences Library is undergoing a major renovation and expansion.
- The library is expanding its collection and services.

Space
- 1,000 square feet of new study area
- 500 square feet of existing study area

Inviting Environment
- Natural light
- Colorful walls
- Comfortable seating

Flexible Functionality
- Multiple use areas
- Adjustable lighting
- Technology integration

Upgraded Services
- New electronic access
- 24/7 access
- Increased collection size

Lessons Learned So Far
- Engage stakeholders early and often
- Communicate effectively
- Plan for future growth
Prepare to do a Poster

Decision to do a poster

A poster can be an effective means of presentation at meetings, conferences or in a classroom setting. By creating a poster you can communicate your main points in a succinct and visual manner, allowing you to clearly present your research to others and engage your peers in conversation.

Find out the requirements

Different types of poster projects may have different requirements. For instance, if you are preparing a poster for a conference, research the poster submission guidelines. Is there a deadline for submitting your abstract? Do the guidelines include specific requirements for layout or content?

If you are preparing your poster for a class project, read the requirements on your syllabus well before your completed poster project is due.

Choose a Topic

Choose a topic that is not only interesting, but one that you feel can be communicated well in a poster. When choosing a topic for your poster, remember that you will not be able to fit all of your research on the poster and you should therefore choose a topic that allows you to present each of your points clearly and succinctly.

Write an Abstract

If you are preparing your poster for a conference you may be required to present an abstract in which you briefly present your concept in paragraph form. If you are preparing your poster for a conference, check to see if you should follow a specific structure or template.
PHOTO CORRECTION TOOLS IN POWERPOINT
SHAPES AND TEXT TOOLS IN POWERPOINT
ALIGNMENT OF OBJECTS TOOLS IN POWERPOINT

- Insert > Shapes or Images > begin to draw on slide
- Click on object > Format (drawing tools) for formatting options
- Click on both objects while pressing “Ctrl”, and then click Arrange.
ALIGNMENT OF OBJECTS TOOLS IN POWERPOINT

• Insert > Shapes or Images > begin to draw on slide

• Click on object > Right click (on mouse) for formatting options

• Click on both objects while pressing “Ctrl”, and then click Group.
For design or imaging help with your poster, visit https://library.unc.edu/house/designlab/.

You can request a consultation with Jennie Goforth, the Research and Design Librarian.

The Design Lab, located in the House Undergraduate Library, is devoted to the teaching and learning of digital design.
YOUR QUESTIONS?
(AND ANSWERS)
THANK YOU!